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About the KM88

Thank you for purchasing the Kurzweil KM88. Read this manual to learn about the KM88 and the KM88
Editor application.

The KM88 is a 4 Zone MIDI controller keyboard which can be used to play and control MIDI sound modules
and software instruments via MIDI cable, USB. The KM88 can be configured with up to 4 Zones, allowing for up
to 4 different instruments to be split or layered on the keyboard.

Each configuration of 4 Zones is called a Multi. The KM88 includes 8 factory Multis containing useful
configurations, and 120 user Multis which can be edited. Each of the 4 Zones in a Multi can have a different
MIDI Program, controller settings, and MIDI transmit channel.

The KM88 controls include a Slider, Joystick, 6 Switch Buttons, and 3 Pedal inputs. Each of these controls
can be configured independently for each Zone in each Multi. In addition to these controls, the KM88 Editor
application includes 9 Virtual Sliders, 9 Virtual Knobs, and 9 Virtual Switches which can be configured
independently for each Zone in each Multi.

Installation

For Windows:
1. Download the Windows version of the Kurzweil KM88 Editor from kurzweil.com.
2. Double click the installer file you’ve downloaded.
3. Follow the on-screen instructions to finish installation.
4. Open the Kurzweil KM88 Editor in one of the following ways:
e |f you’ve selected to create a desktop shortcut during the installation process, simply double click this
shortcut on the desktop.
* Open the Windows Start menu, scroll down the menu to find the letter “K”. Open the KM88 folder to
find the Kurzweil KM88 Editor. Double click this application to open it.
For Mac:
1. Download the Kurzweil KM88 Editor from the Mac App Store and install the application.

2. Open the Applications folder on your Mac. Double click the Kurzweil KM88 Editor to open it.

Getting Started

To use the KM88 with the KM88 Editor application, the KM88 must be connected to the KM88 Editor
application via USB. See the “Connect” section on Page 5 for details on connecting.

When the KM88 Editor is connected to the KM88, engage Play Mode to select Multis and use the
application’s Virtual Controllers. See Page 21 for details on Play Mode.

To create your own User Multis, select Edit Mode. See Page 9 for details on Edit Mode.
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Menu: File

In the File menu, you can load or save a settings backup file, or exit the application.

Multi Name:

Load
In the File menu, click “Load” to select a path (location) and the desired settings file (.km8), then click
“open” to load the backup settings to the application. After loading a backup file, select “Send All Multis”
from the Device menu to update the KM88 with the settings stored in the backup file.

Save

In the File menu, click “Save” to select a path and enter a name, then click “save” to save a backup
file of your Multi and Global settings to your computer.

Note: The Load and Save operations will remember the file path that you’ve selected. The next time you
load/save a settings file, it will use the same file path as the last operation.

Save As

“SaveAs” functions the same as “Save”, but “SaveAs” does not remember the last file path you’ve
selected.

Exit

In the File menu, click “Exit” to close the application.
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Menu: Device

In the Device menu, you can connect the KM88 to the application, and send/receive settings to/from the
connected KM88.

Device Help
Connect :I

hal Settings

Device Help

Connect

Receive Global Settings
Send Global Settings

Receive Current Multi
Send Current Multi
Receive All Multis
Send All Multis

Transposition Transposition

Connect

To use the KM88 with the KM88 Editor application, the KM88 must be connected to the application via
USB cable. Follow the USB Cable Connection instructions below.

e USB Cable Connection:

1. Connect a USB cable from the KM88 USB port to your computer. If you are using a USB hub, make
sure the hub’s power is turned on.

2. Open the Device drop down menu and click “Connect”, you will see the devices dialog (as shown in
the image below).

3. Click the “Devices” list to open it and select KM88 from the list.

4. Click the blue [Connect] button to connect.

Devices:

Connect
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Send Global Settings

Use this to apply adjusted Global Settings while in Edit Mode. Click “Send Global Settings” in the Device
menu, the application will send the Global settings to the connected KM88.

Receive Global Settings

Use this to synchronize the application’s Global Settings after installing a new version of the KM88 Editor
application. Click “Receive Global Settings” in the Device menu, the application will receive Global
settings from the connected KM88.

Note: Use caution as this will overwrite any unsaved changes you have made to Global Settings in the
application.

Send Current Multi

Use this to apply adjusted Multi Settings while in Edit Mode. Click “Send Current Multi” in the Device
menu, the application will send the current Multi settings to the connected KM88.

Note: Use caution as this will overwrite the currently selected Multi stored in the KM88.

Receive Current Multi

Use this to synchronize the application’s selected Multi after installing a new version of the KM88 Editor
application. (If you only have a few Multis to synchronize, this is faster than “Receive All Multis”.) Click
“Receive Current Multi” in the Device menu, the application will receive the current Multi settings from the
connected KM88.

Note: Use caution as this will overwrite any unsaved changes you have made to the currently select Multi
in the application.

Send All Multis
Use this after loading a KM88 backup file (.km8) to apply the loaded Multi settings to the KM88. See Page
4 for details. Click “Send All Multis” in the Device menu, the application will send all Multi settings to the

connected KM88.

Note: Use caution as this will overwrite all user Multis stored in the KM88.

Receive All Multis
Use this to synchronize the application’s Multis after installing a new version of the KM88 Editor
application. Click “Receive All Multis” in the Device menu, the application will receive all Multi settings
from the connected KM88.

Note: Use caution as this will overwrite any unsaved changes you have made to Multis in the application.
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Menu: Help

Help

View help

View Help

Click “View help” in the Help menu to view the PDF manual and get more detailed information about the
application.

About

Click “About” in the Help menu to check the version number of the application.



Edit Mode and Play Mode

About Edit Mode and Play Mode

The KM88 Editor application provides two modes: Edit Mode and Play Mode. When you open the
application or when connecting the KM88 to the application, it will automatically switch to Edit Mode.

Edit Mode is used to edit the settings of the currently selected Multi, and the Global Settings. Switch to Play
Mode to apply and save the edited settings to the KM88.

Play Mode is used to select Multis and use the application’s Virtual Controllers.

Note: When adjusting settings for the currently selected Multi in Edit Mode, your adjustments will not be
applied to the KM88 until you switch to Play Mode, or select “Send Current Multi” from the Device drop
down menu.

About Multis

The KM88 is a 4 Zone MIDI controller which can be used to play and control MIDI sound modules and
software instruments via MIDI cable, USB, or Bluetooth. The KM88 can be configured with up to 4 Zones,
allowing for up to 4 different instruments to be split or layered on the keyboard.

Each configuration of 4 Zones is called a Multi. The KM88 includes 8 factory Multis containing useful
configurations, and 120 user Multis which can be edited. Each of the 4 Zones in a Multi can have a different
MIDI Program, controller settings, and MIDI transmit channel.

The KM88 controls include a slider, joystick, 6 switch buttons, and 3 pedal inputs. Each of these controls
can be configured independently for each Zone in each Multi. In addition to these controls, the KM88 Editor
application includes 9 Virtual Sliders, 9 Virtual Knobs, and 9 Virtual Switches which can be configured
independently for each Zone in each Multi.

Edit Mode

Click the [Edit Mode] button to engage Edit mode. When the [Edit Mode] button turns blue, Edit Mode is
engaged.

In Edit Mode, you can edit the Global Settings and User Multis, send the edited settings to the connected
KM88 and/or receive settings from the KM88. For more details, see the Send/Receive options on Page 7.

Note: When adjusting settings for the currently selected Multi in Edit Mode, your adjustments will not be
applied to the KM88 until you switch to Play Mode, or select “Send Current Multi” from the Device drop
down menu.

See the sections below for details on using each page in Edit Mode.
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Edit Mode and Play Mode

Edit Mode: Global Settings Page

Click the [Global Settings] button to view the Global Settings page. When viewing the Global Settings page,
the [Global Settings] button turns blue.

Global Settings apply to all Multis. When Edit Mode is engaged, you can adjust the parameters on the
Global Settings page.

Note: After adjusting Global Settings in Edit Mode, your adjustments will not be applied to the KM88 until
you switch to Play Mode, or select “Send Global Settings” from the Device drop down menu.
Edit Mode: Global Settings Parameters
Velocity Map
The Velocity Map parameter determines the way the KM88 generates MIDI velocities. Different maps
generate different MIDI velocity values for the same physical key strike velocity. After applying Global

Settings to the KM88, the Velocity Map setting will be remembered the next time the KM88 is powered on.

The default map (Linear) provides the widest range of velocity expression, but you may want to choose a
different map if the default does not suit your playing style. You can select from these settings:

@ Linear, Light1, Light2, Light3, Hard1, Hard2, Hard3
The Linear map allows MIDI velocities to pass unchanged. It follows a linear response.

The Light maps make it increasingly easier to produce high MIDI velocity values for the same key strike
velocity (with Light3 being the easiest). These maps work best for those with a light touch.

The Hard maps make it increasingly harder to produce high MIDI velocity values for the same key strike
velocity (with Hard3 being the hardest). These maps work best for those with a heavy touch.

Transposition

The Transposition parameter allows you to tune the pitch of the unit in semitones. This setting is reset to 0
when the KM88 is powered on.

Auto PowerOff Time

The KM88 has an automatic power saving feature (Auto Power Off) that can automatically power off the
KM88 after a period of inactivity, in order to conserve electricity. By default this is set to 4 hours. After
applying Global Settings to the KM88, the Auto PowerOff Time setting will be remembered the next time
the KM88 is powered on.

System ID
The System ID number is used to identify each KM88 when multiple KM88s are connected to the same

computer. Each KM88 must be set to a different System ID number. After applying Global Settings to the
KM88, the System ID setting will be remembered the next time the KM88 is powered on.
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Edit Mode and Play Mode

Edit Mode: Multi Settings

Each configuration of 4 Zones is called as a Multi. The KM88 includes 8 factory Multis containing useful
configurations, and 120 user Multis which can be edited. Each of the 4 Zones in a Multi can have a different
MIDI Program, controller settings, and MIDI transmit channel.

The KM88 controls include a slider, joystick, 6 switch buttons, and 3 pedal inputs. Each of these controls
can be configured independently for each Zone in each Multi. In addition to these controls, the KM88 Editor
application includes 9 Virtual Sliders, 9 Virtual Knobs, and 9 Virtual Switches which can be configured
independently for each Zone in each Multi.

Each Multi can be saved with its own settings for the Buttons page and Zones page. See the sections
below for details on using each of the Multi Settings pages in Edit Mode.

Note: When adjusting settings for the currently selected Multi in Edit Mode, your adjustments will not be
applied to the KM88 until you switch to Play Mode, or select “Send Current Multi” from the Device drop
down menu.

Multi List

The drop-down list on the left side shows the Multi numbers and names. Click this list to open it and
select a Multi.

Multi Name

When Edit Mode is selected, for User Multis 9-128, you can rename the selected Multi by using the Multi
Name field below the Multi list.

Virtual Controllers

When Edit Mode is selected, click on any of the Sliders, Knobs, or Buttons on the bottom of the window
to jump to viewing their associated parameters.

° File Device Help Play Mode " EditMode K lvl RZWEIL Kmssg

Global Settings Zone 3 Zone 4 Copy Zone Paste Zone

~ - -~ Key Range i g M v MIDI Program 1
Off Mute Active

9:Muilti 008

Multi Name:
Multi 009 Velocity Range i MIDI Bank MSB: |0

Pitch Bend Up Range MIDI Channel 1
Buttons

Zones Transposition: 0 v Pitch Bend Down Range MIDI Destination | MIDI / USB

Pl P2 v

e (HDDDDDDD

0

0

10



Edit Mode and Play Mode

11

Edit Mode: Buttons Page

Click the [Buttons] button to view the Buttons page. When viewing the Buttons page, the [Buttons] button
turns blue. Use the Buttons page to assign functions to the six front panel buttons of the KM88.

Click one of the six buttons on the Buttons page to view it’s assignment in the Function list. When you
select one of the six buttons on screen, the button will turn blue.

Note: When you are not viewing the Buttons page, you can also click on any of the 6 Buttons on the bottom
left of the window to jump to viewing the selected Button on the Buttons page.

Play Mode Edit Mode

Global Settings

Mute / Activate a zone

MIDI Panic

Edit Mode: Buttons Page Parameters

In each Multi, each of the six front panel buttons can be assigned to one of the following functions:

Multi X

This function allows you to specify a Multi number which will be selected when the button is pressed. This
is useful for selecting frequently used favorite Multis.

Multi + and Multi -

These functions select the next or previous Multi in the list when the button is pressed. These functions
should typically be assigned to two adjacent buttons, Multi - at the left and Multi + at the right. When both
functions are assigned, press the two assigned buttons at the same time to select Multi 1.

Transposition + and Transposition -

These functions tune the pitch of all Zones in all Multis in semitones when the button is pressed.
These functions should typically be assigned to two adjacent buttons, Transposition - at the left and
Transposition + at the right. When both functions are assigned, press the two assigned buttons at the
same time to reset transposition.

Note: These transpositions functions are applied in addition to any Transposition applied on the Zones
sub-page 1 of Each Zone, and any Transposition applied on the Global Settings page.
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MMC Play and MMC Stop

These functions send MMC Play or MMC Stop messages when the button is pressed. MMC Play
and MMC Stop messages can be used to start or stop playback in connected hardware or software
sequencers (such as a hardware drum machine or a DAW on a computer).

Programmable Button

This function allows you to control a Virtual Switch assignment when the button is pressed. After clicking
on “Programmable Button” in the Function list, click on the Virtual Switch drop down list to select a Virtual
Switch to control. Virtual Switches can be assigned on Zones sub-page 3. For details see Page 17.

Mute / Activate a Zone

This function allows you to switch a Zone’s Status between Mute and Active when the button is pressed.
You can assign one button to control one or multiple Zones. After clicking on “Mute / Activate a Zone”

in the Function list, use the four check boxes to select which Zones the button will control. Zones with a
Status set to Off can not be controlled.

MIDI Panic

This function will send a MIDI Panic message when the button is pressed. MIDI Panic stops all notes, sets
all CC controller values to 0, and reloads the selected Multi.
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Edit Mode: Zones Page

Click the [Zones] button to view the Zones page. When viewing the Zones page, the [Zones] button turns
blue. Use the Zones page to set Zone specific settings for each of the four Zones in the selected Multi.

Zones

There are four Zones in each Multi. Use the [Zone 1-4] buttons to select a Zone. The selected Zone button
will turn blue, and the interface will show the selected Zone’s parameter settings. Each Zone has the
same parameters, which can be set to different settings for each Zone.

Zones Sub-Pages

The Zones page has four sub-pages. Use the [1-4] or Left/Right buttons to select a Zones sub-page.

File Device Help Play Mode " EditMode K lvl RZWEIL Kmssg

Global Settings Zone 3 Zone 4 Copy Zone

9:Multi 009 ® o o Key Range I : v v MIDI Program 1

Multi Name: off Mute Active

Multi 009 Velocity Range i MIDI Bank

Pitch Bend Up Range MIDI Channel 1
Buttons

Zones Transposition: 0 v Pitch Bend Down Range MIDI Destination | MIDI / USB

Pl P2 v

e (HDDDDDDD

0

0

Copy Zone and Paste Zone

If you want to use the same settings in multiple Zones, click the [Copy Zone] button to copy the settings
of the current Zone, then use the [Zone 1-4] buttons to select a target Zone and click the [Paste Zone]
button to paste the settings to that Zone.

Virtual Controllers

Click on any of the Sliders, Knobs, and Switches on the bottom half of the window to jump to viewing
their associated parameters.
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Edit Mode: Zones Sub-Page 1 Parameters

Zone 2 Zone 3 Zone 4 Copy Zone

Key Range i P Y MIDI Program 1
Off Mute Active
Velocity Range i MIDI Bank MSB: |0

Pitch Bend Up Range MIDI Channel 1

Transposition: 0 v Pitch Bend Down Range MIDI Destination | MIDI/ USB

Status

Click the Off, Mute, and Active buttons in the top left of the Zones sub-page 1 to set the Status of the
currently selected Zone. You can select from these settings:

oOff:  The Zone will not transmit any MIDI messages.

@ Mute: The Zone will only transmit MIDI Program Change messages and MIDI CC messages for the
Initial State of each controller when the Multi is selected.

@ Active: The Zone will transmit all MIDI messages.

Transposition
The Transposition parameter allows you to tune the pitch of currently selected Zone in semitones.

Note: This Transposition parameter is applied in addition to any Transposition by the Buttons page
functions of the current Multi, and any Transposition applied on the Global Settings page.

Key Range Min / Max

The Key Range Min and Max fields set the lowest and highest keys which will play a note in the Zone. Use
these parameters in each Zone to Split or Layer instruments across the keyboard.

Velocity Range
The Velocity Range Min and Max fields set the lowest and highest velocities which will play a note in the

Zone. Use these parameters in each Zone to trigger different instruments based on the velocity of notes
played.

Pitch Bend Up Range / Pitch Bend Down Range

The Pitch Bend Up Range and Pitch Bend Down Range fields determine the pitch bend range of the
joystick when moving the joystick right and left.

Note: Some MIDI instruments do not respond to pitch bend range messages. In this case the pitch bend
range must be specified on the connected MIDI instrument.

14
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MIDI Program

Use the MIDI Program parameter to select the MIDI instrument sound (Program) which will be controlled
by the Zone. Most MIDI instruments have sounds organized in Banks of 128 Programs.

The MIDI Program parameter determines the MIDI Program Change message that the currently selected
Zone sends when the Multi is selected. Select a value from 1-128 to send the desired Program Change
number.

If you select NONE, the currently selected Zone will not send a Program Change message when the Multi
is selected. NONE is useful when you don’t want the Multi to automatically change the program, and wish
to manually select the Program on the connected MIDI instrument.

Note: The KM88 displays Program Change numbers as 1-128 for each Bank. If the connected MIDI

instrument displays Program Change numbers as 0-127 for each Bank, the connected MIDI instrument
may select a program 1 value lower than the value selected on the KM88.

MIDI Bank

The MIDI Bank parameter determines the MIDI Bank Change message that the currently selected Zone
sends when the Multi is selected. Use the MSB and LSB fields to set the MIDI Bank number.

MIDI instruments typically contain banks of 128 Programs. When selecting from the first 128 Programs,
leave the MSB and LSB fields set to 0.

To select a Program number greater than 128, you must select a MIDI Bank. For most MIDI instruments,
leave MSB set to 0, then set LSB values 0-127 to select Banks 1-128 (sometimes referred to as Banks

0-127). For Banks greater than 128, increase the MSB value to 1 to select the second 128 Banks, and so
forth. (MSB sends CC message 0, and LSB sends CC message 32.)

MIDI Channel

The MIDI Channel parameter sets the MIDI channel number for the currently selected Zone. Each Zone
can use a different MIDI Channel, allowing for a different instrument sound to be played on each channel.

MIDI Destination

The MIDI Destination parameter determines whether MIDI data generated by the currently selected Zone
is sent to the MIDI Out port, USB port, or any combination of these destinations.
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Edit Mode: Zones Sub-Page 2 and 3 Parameters
Zones sub-pages 2 and 3 contain various Switch and CC Controllers.

Switch Controllers (Sustain Pedal, SW Pedal, 9 Virtual Switches) can send an On and Off value, and are
useful for enabling and disabling things like Sustain, Layers, and Effects.

CC Controllers (Volume Slider, Expression Pedal, Stick Up/Down, 9 Virtual Sliders, 9 Virtual Knobs) can
send continuous values from 0-127, and are useful controlling things like Volume, Filter Frequency, and
Effects Amount.

Zone 3 Zone 4 Copy Zone Paste Zone

o - Switch Controller: | 1:Sustain Pedal CC Controller: 1:Volume Slider
Mute Active
Mode Momentary Mode MIDI CC

MIDI Destination 84:Damper pedal(sustain) MIDI Destination 7:Channel Volume
Initial State None Initial State None
On Value Max Value

Off Value Min Value

Zone 1 Copy Zone

Virtual Knob: 1 Virtual Slider: Virtual Switch: 1

Mode MIDI CC Mode MIDI CC Mode Toggle

MIDI Destination 71:Sound Controller 2 MIDI Destination 12:Effect Control 1 MIDI Destination 29:Undefined
Initial State None Initial State None Initial State None

Max Value Max Value On Value

Min Value Min Value Off Value

Switch Controller (Sustain Pedal, SW Pedal, 9 Virtual Switches)

Each of the Switch Controllers (Sustain Pedal, SW Pedal, 9 Virtual Switches) can be assigned to transmit
a MIDI CC message on the Zone’s MIDI channel. Each Switch Controller can send an initial value

when the Multi is selected, and a specified On and Off value when the switch is On or Off. Each Switch
Controller can also be set to Toggle or Momentary Mode.

To assign the Sustain Pedal or SW Pedal, go to the Zones sub-page 2 and click on the Switch Controller
drop down list, then click the desired controller in the list. The settings for the selected controller will be
shown in the fields below the Switch Controller drop down list.

To assign the 9 Virtual Switches, go to the Zones sub-page 3 and click on the Virtual Switch drop down
list, then click the desired controller in the list. The settings for the selected controller will be shown in the
fields below the Virtual Switch drop down list.

Note: You can also click on any of the Virtual Switches on the bottom right of the window to jump to
viewing their associated parameters.

All Switch Controllers have the following parameters: Mode, MIDI Destination, Initial State, On Value / Off
Value. See below for details.
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Mode

When Mode is set to Momentary, the Switch Controller sends its “On Value” when pressed, and its “Off
Value” when released.

When Mode is set to Toggle, the Switch Controller alternates between sending its “On Value” or “Off
Value” each time it is pressed. No value is sent when the controller is released.
MIDI Destination

Use the MIDI Destination field to determine which CC message the Switch Controller will send. Select a
Destination based on the MIDI CC numbers the connected MIDI instrument is assigned to respond to.

Note: MIDI Destinations are named with their default function. Depending on the MIDI instrument you
are controlling, it may or may not perform the named function, or any function. You may be able to make

custom CC number assignments for functions on the connected MIDI instrument. For Switch Controllers,
many MIDI instruments respond to Destination 64 Damper Pedal (Sustain).

Initial State
The Initial State parameter determines the state of the Switch Controller when the Multi is selected.

If Initial State is set to None, no CC message will be sent when the Multi is selected.

If Initial State is set to On, a CC message will be sent when the Multi is selected using the controller’s
selected MIDI Destination and the value set in the On Value field.

If Initial State is set to Off, a CC message will be sent when the Multi is selected using the controller’s
selected MIDI Destination and the value set in the Off Value field.
On Value / Off Value

The On Value and Off Value parameters determine the value that will be sent for the assigned MIDI
Destination when the Switch Controller is turned On or Off.
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CC Controller (Volume Slider, Expression Pedal, Stick Up/Down, 9 Virtual Sliders, 9
Virtual Knobs)

Each of the CC Controllers (Volume Slider, Expression Pedal, Stick Up/Down, 9 Virtual Sliders, 9 Virtual
Knobs) can be assigned to transmit a MIDI CC message or MIDI pressure message on the Zone’s MIDI
channel. Each CC Controller can send an initial value when the Multi is selected, and continuous values
from 0-127.

To assign the Volume Slider, Expression Pedal, or Stick Up/Down, go to the Zones sub-page 2 and
click on the CC Controller drop down list, then click the desired controller in the list. The settings for the
selected controller will be shown in the fields below the CC Controller drop down list.

To assign the 9 Virtual Sliders or 9 Virtual Knobs, go to the Zones sub-page 3 and click on the Virtual
Slider or Virtual Knob drop down list, then click the desired controller in the list. The settings for the
selected controller will be shown in the fields below each drop down list.

Note: You can also click on any of the Virtual Sliders or Knobs on the bottom of the window to jump to
viewing their associated parameters.

All CC Controllers have the following parameters: Mode, MIDI Destination, Initial State, Max Value / Min
Value. See below for details.

Mode

When Mode is set to MIDI CC, the CC Controller sends MIDI CC messages, and you can select a
destination from the selected controller’s MIDI Destination field.

When Mode is set to Pressure, the CC Controller sends MIDI pressure messages. Pressure messages
often control Vibrato or Filter Frequency. Depending on the MIDI instrument you are controlling, it may
or may not respond to pressure messages. You may be able to make custom pressure assignments for
functions on the connected MIDI instrument.

MIDI Destination

When Mode is set to MIDI CC, use the MIDI Destination field to determine which CC message the CC
Controller will send. Select a Destination based on the MIDI CC numbers the connected MIDI instrument
is assigned to respond to.

Note: MIDI Destinations are named with their default function. Depending on the MIDI instrument you
are controlling, it may or may not perform the named function, or any function. You may be able to make
custom CC number assignments for functions on the connected MIDI instrument. For CC Controllers,
many MIDI instruments respond to Destination 1 Modulation Wheel for controlling Vibrato or Filter
Frequency, Destination 7 Channel Volume, Destination 10 Pan, and Destination 11 Expression.

Initial State
The Initial State parameter determines the CC value that will be sent for the selected controller when
the Multi is selected. Select a value from 0-127 to send the desired CC value. If you select NONE, the
selected CC Controller will not send a CC message when the Multi is selected.

Max Value / Min Value

The Max Value and Min Value parameters determine the range of values that can be sent for the selected
CC Controller.
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Edit Mode: Zones Sub-Page 4 Parameters

Zone 1 Zone 2 Copy Zone Paste Zone
Key Number | 1:AD

Key Mode Key

Zone 1 Zone 2 Copy Zone Paste Zone

Key Number | 1:A0 NONE ¥
Key Mode Chord NONE ~

NONE ~

NONE

Key Number
Each of the Keys in a Zone can be assigned to transmit the original note of the Key, or a Chord. To assign

a Key, go to the Zones sub-page 4 and click on the Key Number drop down list, then click the desired
Key Number in the list.

Key Mode
When Key Mode is set to Key, the selected Key Number plays the original note of the key.

When Key Mode is set to Chord, the selected Key Number plays a chord of up to 8 notes.

Note 1 - Note 8

When Key Mode is set to Chord, the Note 1 through Note 8 fields appear. Use these fields to select a
chord of up to 8 notes. Use the Vel fields to set a velocity from 0-127 for each note.
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Play Mode

In Play Mode, you can select and play Multis, and use the Virtual Sliders, Knobs, and Buttons.

Play Mode: Preparation

To engage Play Mode, the KM88 must be connected to the KM88 Editor application. For details see
“Connect” on Page 5.

When the KM88 is connected to the KM88 Editor application, click the [Play Mode] button to engage Play
Mode.

Note: When engaging Play Mode, any adjustments made to the currently selected Multi or on the Global
Settings page will be applied to the KM88. A message will prompt you to continue or cancel. Click [OK] to
continue to Play Mode and apply any adjusted settings, or click [Cancel] to remain in Edit Mode.

If you see the “Device is not ready” message, it indicates the KM88 is not connected to the KM88 Editor
application. Click [OK], connect the KM88, and try again. For details on connecting, see “Connect” on
Page 5.

When the [Play Mode] button turns blue, Play Mode is engaged.
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Edit Mode and Play Mode

Play Mode: Interface

The drop-down list on the left side shows the Multi numbers and names. Click this list to open it and
select a Multi. You can use the Sliders, Knobs, and Buttons on the bottom of the window to control the
currently selected Multi.

In Play Mode, parameters on the Global Settings page, Buttons page, and Zones page can be viewed but
not edited. Select Edit Mode to edit parameters on these pages.
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Trademarks & Licenses

©2020 HDC-Young Chang Co., Ltd. All rights reserved.

Kurzweil® is a product line of HDC-Young Chang Co., Ltd. Kurzweil®,
HDC-Young Chang® are trademarks of HDC-Young Chang Co., Ltd.

All other trademarks and copyrights are property of their respective companies.
Product features and specifications are subject to change without notice.
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